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If you have problems 

First make sure to check the “Troubleshooting” section in this document and the 
Knowledge Base on our website: www.palmsens.com/knowledgebase/ 
This page contains support information on installation, software updates, and training. 

Please make sure your software and firmware are up-to-date.  

 
In case of persistent problems: 
Use the contact form:    www.palmsens.com/contact/ 
Give us a call:    +31 30 2459211 
Or send an email:   info@palmsens.com 

Try to describe the problem as detailed as possible. Sending us the relevant method 
files, data files and screenshots can be helpful. 

Please include your instrument model and serial numbers, as well as any applicable 
software and firmware version you are using.  

Limited Warranty 

Except as otherwise provided herein, PalmSens BV warrants to buyer three years from 
the date title to the product passes (transfer date of goods from seller to buyer), each 
product sold hereunder will be free of defects in materials or workmanship and will 
conform to specifications set forth in PalmSens BV’s published data sheets or, where 
applicable, user manuals for PalmSens BV’s system products in effect at the time title 
passes. 

PalmSens BV’s sole liability and responsibility for products under this warranty is for 
PalmSens BV to repair or replace any product that is returned to it by buyer or credit 
buyer’s account for such returned product, provided that PalmSens BV shall have the 
right to reject any such remedy where PalmSens BV determines that the warranty does 
not apply. Products returned to PalmSens BV for warranty service will be shipped to 
PalmSens BV at buyer’s expense and will be returned to buyer at PalmSens BV’s expense. 
PalmSens BV’s obligation to honor its warranty for a product is contingent upon receipt 
of payment in full for such product. 

See our website for more detailed information:  

www.palmsens.com/terms-and-conditions/ 
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Disclaimers  

PalmSens BV is not liable for any direct, indirect, incidental, or consequential damages 
resulting from the use or misuse of its instruments, including but not limited to: 

▪ Damage to the instrument caused by improper handling, unauthorized 
modifications, or use outside the recommended specifications. 

▪ Malfunction or incorrect results due to improper sample preparation, 
contamination, or incorrect experimental setup. 

▪ Loss of data or research results caused by software crashes, hardware failures, 
or power interruptions. 

▪ Personal injury or property damage resulting from incorrect wiring, exposure 
to hazardous chemicals, or misuse of electrical connections. 

Results obtained using PalmSens instruments depend on experimental conditions, 
sample properties, and user expertise. Users are responsible for verifying the validity of 
their data.  

Changes in specifications and typing errors reserved. Every effort has been made to 
ensure the accuracy of this document. However, no rights can be claimed by the 
contents of this document. 

By using PalmSens instruments, the user acknowledges and accepts these limitations 
and responsibilities. 

See Appendix A for CE declaration of conformity. 

Copyrights  

EmStat4T Operator’s Manual.  

Copyright © 2024-2026, PalmSens BV, all rights reserved.  

PSTrace, MultiTrace, Nexus, PalmSens, EmStat, MultiEmStat and Sensit are trademarks 
of PalmSens BV. 

No part of this document may be copied or reproduced in any form without the prior 
written consent of PalmSens BV. 
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1 Introduction 

1.1 The scope of this manual 
This manual covers the handling, characteristics, troubleshooting, and other practical 
information regarding the hardware specifics of the EmStat4T, as well as maintenance 
and compliance.  

Please refer to the Quick Installation Guide that was supplied with the instrument for 
instructions on installing the instrument and the software. Additionally, the section 
Getting Started in the digital PSTrace Manual, that is installed with the software, 
provides detailed instructions for conducting first measurements with your instrument. 

 
Initial setup and basic operational instructions for conducting 

initial measurements are detailed in the  
“Quick Installation Guide” supplied with the instrument. 

The PSTrace Manual is an in-depth document covering not only the PSTrace software 
but also the hardware limitations for each technique supported by the instrument. It is 
written to give you a full understanding of both the software and hardware aspects, 
making sure you're well-equipped to use all the functionalities of the EmStat4T. 
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Figure 1 - The EmStat4T SPE (left) and EmStat4T SNS (right) 

1.2 About the EmStat4T 
The EmStat4T is a one-of-a-kind device that functions as a potentiostat, galvanostat, 
and Electrochemical Impedance Spectroscopy (EIS) analyzer. The battery powered 
EmStat4T is designed for conducting electrochemical research and can also be used as 
a standalone reader for specific sensor applications. At its core is the EmStat4M LR 
potentiostat module it connects wirelessly (via Bluetooth) or via a USB cable to a PC, 
smartphone or tablet. Additionally, it can function independently using its integrated 
touch screen.  

A visual editor allows users to create programs on the EmStat4T enabling users without 
programming experience to develop a wizard -style app for specific sensor 
applications.  

The integrated QR and bar code scanner enables users to easily identify sensors via a 
QR code on the package, which may also include calibration data, an expiry date, and 
other useful information. It can also provide the EmStat4T and any apps running on it 
with this sensor-specific data. Backed by an advanced imaging engine, the scanner 
supports a broad array of 1D and 2D barcode formats, offering precision down to 0.1 
mm (4 mil) and a reliable depth of field up to 400 mm. This ensures high-speed, flexible 
scanning whether the instrument is deployed out in mobile settings, such as point-of-
care environments. Additional use cases involve scanning QR codes for operator 
information or sample data.  

The cell connector located on the front of the device is modular, allowing users to easily 
exchange it for compatibility with specific sensors or cells.  
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Features 

 

 

1. Full-color 2.4” 240x320 TFT touch screen 
2. Touch power button 
3. Exchangeable sensor interface module 

(Either with LEMO connector for cell cable, or with connector for direct use of 
Screen-Printed Electrodes or SPEs). 

4. Rubber grip 
5. USB-C port 
6. Integrated 1D/2D QR and barcode scanner 
7. Rubber feet 
8. 3000 mAh Li-Po battery 
9. Screw for the battery lid 
10. Screw for releasing the sensor interface module 

 

  

https://www.tme.eu/nl/katalog/tft-displays_112284/?params=1132:1495608_displayresolutie:240x320
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1.3 EmStat4T configurations 
The EmStat4T is available in different configurations. The EmStat4T is available with or 
without a license for running Electrochemical Impedance Spectroscopy or EIS. A 
limited configuration can always be upgraded remotely via software to add 
functionality. Please contact PalmSens BV, if you are interested in upgrading your 
EmStat4T. 

Two standard options for the front Connection Module are available from PalmSens BV: 

1. Version SNS: with LEMO connector for use with PalmSens standard 1 meter cell 
cables 

2. Version SPE: with connector for Screen-Printed Electrodes with common 
0.1” (2.54 mm) pitch and a maximum width of 10 mm. 

For options regarding tailored Connection Modules for a bespoke sensor or cell 
interface, contact PalmSens BV. 

The following table shows the available standard configurations of the EmStat4T and 
the corresponding  article codes.  

Table 1 - EmStat4T hardware configurations available from PalmSens BV 

Article code Connection Module EIS capable 

C-ES4T-SNS.F0 SNS NO 

C-ES4T-SNS.F1 SNS YES 

C-ES4T-SPE.F0 SPE NO 

C-ES4T-SPE.F1 SPE YES 

 
A license for Electrochemical Impedance Spectroscopy (EIS) can 

always be upgraded remotely via software. 

1.4 Modes of operation 
The EmStat4T offers two main modes of operation: 

▪ Remote Controlled: In this mode the instrument functions as a standard 
potentiostat for research purposes, where PSTrace for Windows or the PStouch 
app for iOS or Android controls the instrument. The connection to the PC, 
smartphone or tablet can either be via USB or via Bluetooth. 

▪ Standalone: With the ability to run apps directly on the device, users perform 
sensor measurements and analyses without needing a separate computer, 
making it more portable and convenient. 
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1.5 Accessories 
The EmStat4T is supplied standard with the following items. 

EmStat4T SNS & SPE versions include: 

▪ Shielded USB-C cable to USB-A cable 
▪ Dummy cell 
▪ USB stick with software 
▪ A soft-shell carrying case 
▪ Quick Start document 
▪ Operator’s Manual 
▪ Certificate of Calibration 

EmStat4T SNS version includes additional: 

▪ 1 meter cell cable with 2 mm banana plugs, stackable connectors 
▪ Croc clips for every lead (2 mm) 

1.6 Software 
The EmStat4T is used with PSTrace 5.12 for Windows or later. PSTrace 5.12 comes with 
the integrated Visual MethodSCRIPT Editor and EmStat4T Configuration tool. For 
regular operation (Remote Controlled Mode), including running measurements and 
analyzing data, you can control the EmStat4T directly using PSTrace 5. 

For building small apps that run on the EmStat4T, and for configuring the instrument's 
style and behavior, the following two tools within PSTrace 5 can be used: 

1. The Visual MethodSCRIPT Editor: The Visual MethodSCRIPT Editor and the 
EmStat4T configuration tool can be used to program the EmStat4T to run small 
wizard-style apps.  The Visual MethodSCRIPT Editor can be found in the PSTrace 
main menu under ‘Tools’ → ‘Visual MethodSCRIPT Editor...’ 
 
See for more information section Developing apps on page 19 
 

 

Figure 2 - The Tools menu in PSTrace 5.12 or later for opening the Visual 
MethodSCRIPT Editor 

2. The EmStat4T Configurator: The EmStat4T Configurator tool can be found in 
the main menu under ‘Tools’ → ‘Instrument Settings…’ and in the window that 
appears click the button ‘EmStat4T Configurator’. 
 
See for more information section  Configuring the style and behavior on page 
21 
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Figure 3 - Opening the EmStat4T Configurator tool in PSTrace 5 
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2 Operating the EmStat4T 

2.1 Preparing for operation 
If the EmStat4T was taken from a cold location into a warm humid location, water vapor 
might condense at the inside. If this is the case, it is important to leave the instrument 
in the room for at least an hour before switching it on. 

2.2 Switching on and off 
The power button is located underneath the touch display. To turn on the EmStat4T, 
touch and hold the power button (no force needed) for two seconds until you hear a 
short beep, indicating the device is booting. A short melody of three tones sounds 
when the EmStat4 has fully booted.  

 

 

Figure 4 - Touching the EmStat4T power button 

Touch the power button for three seconds to switch the instrument off again. 
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2.3 Charging 
A full charge of the EmStat4T takes about 3 hours. Any USB power source can be used 
for charging. To charge at maximum speed, ensure you use a charger and cable that 
can support 1.5 A at 5 V. 

2.4 Connecting via USB 
The EmStat4T has a USB Type-C (USB-C) port and uses the Full-Speed specification. The 
EmStat4T can be used with any common USB port. Connect the EmStat4T to your 
computer using the supplied USB-C cable. 

For optimal performance, PalmSens recommends using only the shielded USB฀C to 
USB฀A (standard rectangular plug) cable supplied as standard with the instrument. Use 
of other or longer cables may increase susceptibility to electromagnetic interference 
and may affect measurement performance. Similarly, if feasible, it is recommended to 
refrain from utilizing a USB hub or docking station. 

The USB-C port on the EmStat4T is used for both power and data communication. To 
operate the device via a PC, make sure PSTrace 5.12 or later is installed, which ensures 
that the correct drivers are present. 

2.5 Connecting via Bluetooth 
Every EmStat4T has a unique Bluetooth name. The Bluetooth name of the EmStat4T 

instrument can be found by tapping the hamburger-menu icon ฀  on the display when 
the instrument is idle.  

 

 

Figure 5 - The hamburger menu (three stacked horizontal lines) is found in the upper 
right corner of the idle screen 

The Bluetooth name always starts with the letters PS, followed by the last 4 characters 
of its MAC address. For example: PS-6AEF. When connecting with the EmStat4T for the 
first time, a pairing code will be required by the host. This code is shown on the display 
of the EmStat4T as “Pair Code” when the host is requesting the code and can be 5 or 6 
digits. A random Pair Code is generated every time the device is paired with a host. 
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Figure 6 - Entering the Pair Code in Windows 11 when connecting for the first time to 
the EmStat4T 

2.6 Touch display 
The touch display is meant for use with Wizard-style mini apps which can be designed 
and generated using the Visual MethodSCRIPT Editor. These apps allow for creating a 
series of steps the user must follow on the display to run measurements, entering or 
scanning sensor or user information, doing calculations on the measurement data and 
presenting and storing the results. This allows for applications where a user or operator 
is following these steps in an industrial or medical environment carrying out a 
concentration determination. When the instrument is used in the remote-controlled 
operation mode, being controlled by a PC or smartphone, the touch screen doesn’t 
serve a purpose apart from showing idle status information and which measurement is 
running.  

When connecting to the USB port of a PC, Bluetooth will switch off automatically unless 
there is a Bluetooth connection active. This allows the instrument to be charged via the 
PC while a Bluetooth connection is present. The instrument can also be charged with 
any other USB-C power source while a Bluetooth connection is present. 
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2.7 Connection Modules 
The EmStat4T is supplied with either the SNS Connection Module (Figure 7) for use with 
the standard 1-meter cell cable provided by PalmSens BV, or the SPE Connection 
Module (Figure 8) designed for common form-factor screen-printed electrodes. 

See also section SPE Connection Module pin-out on page 26 

 

 

Figure 7 - SNS Connection Module with LEMO connector for 1 meter cell cables 

 

Figure 8 - SPE Connection Module with SPE connector for Screen-Printed Electrodes 

In the case of the SNS module, the cell cable is connected to the EmStat4T by means of 
a LEMO push-pull connector. Make sure the red dot on the connector is facing upwards 
when plugging the connector into the EmStat4T. See Figure 9. 
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Figure 9 - LEMO push-pull cell connector 

2.7.1 Replacing the Connection Module 

The Connection Module in the front comes standard in two versions, one for use with 
Screen-Printed Electrodes (SPE version) and one for use with the PalmSens standard 1 
meter cell cable. The Connection Module can easily be exchanged by removing the 
small Philips screw at the bottom side of the device (step 1) and by pushing the 
Connection Module outwards (step 2). See the figure below. 

 

 

Figure 10 - Replacing the Connection Module 
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3 Running measurements 

The PSTrace software for Windows and the PStouch app for Android allows you to 
perform all electrochemical techniques supported by the connected EmStat4T 
instrument. This section outlines how to set up a typical measurement using these 
applications. 

For detailed information on specific techniques, including their options and limitations, 
please refer to the PSTrace Manual. 

This section covers usage in Remote Controlled Mode, where the instrument is 
operated entirely via PSTrace or PStouch. In this mode, the EmStat4T’s touch screen is 
not used for control but will display basic status information during measurements. 

 
The options and limitations for each technique are described in 

the PSTrace Manual. 

More theoretical background information about electrochemical techniques can be 
found in: 

▪ Christopher M.A. Brett and Ana Maria Oliveira Brett, Electroanalysis (Oxford 
Chemistry Printers, 64) Oxford Science Publications, ISBN-13: 978-0198548164 

▪ Joseph Wang, Analytical Electrochemistry 3rd ed, John Wiley & Sons, ISBN-13 
978-0471678793 

3.1 Connecting a cell to the potentiostat 
This section describes how to connect the EmStat4T SNS version to an electrochemical 
cell using the 1-meter cell cable. 

The 1-meter cell cable is terminated with 2-mm banana plugs as the lead connectors for 
the cell / electrodes / sample. Each lead is accompanied by a crocodile (alligator) clip 
of the same color. 
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We advise keeping an unused lead connected with its crocodile 
clip. This practice prevents accidental electrical contacts with 
the exposed banana plug, minimizing the risk of unintended 

electrical contacts. 

See Table 3 for EmStat4T standard cable lead colors. 

Each electrode cable is individually shielded, and the entire cable features an external 
shielding mesh. The shielding extends up to the beginning of the banana plug. When 
you are using a Faraday cage, it is advisable to keep the entire banana plugs inside the 
Faraday cage housing to ensure the cage shields the banana plug.  

3.1.1 2-electrode cell connection 

For a 2-electrode setup, combine the counter and reference electrode leads. The 
counter electrode plug of the cell  cable is stackable, allowing for convenient 
combination.  

 

  

Figure 11 - 2-electrode cell connection 

During a measurement in a 2-electrode setup, the potential will be applied between the 
two electrodes, and the current will flow between the same two electrodes. This means 
the applied potential includes the potential drop across the working electrode’s 
interface, the potential drop across the solution, and the potential drop across the 
counter electrode’s interface. Any changes at the counter electrode will influence the 
result. If your counter electrode is expected to be stable during the measurement due 
to low currents or a short duration of the measurement, you can use this setup almost 
equivalent to a 3-electrode setup. Otherwise, this setup is only used for applications 
where the full cell potential is an interesting parameter, for example, fuel cells , 
batteries, capacitors, dummy cells or electronic components. 
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3.1.2 3-electrode cell connection 

The 3 -electrode setup is the most common configuration for electrochemical 
measurements.  

 

Figure 12 - 3-electrodes cell connection 

Similar to the 2 -electrode setup, the working electrode carries the current and 
potential. In this setup, the counter electrode also carries the current and polarizes 
versus the working electrode (WE). However, the potential is measured between the 
working and reference electrodes, denoted as WE vs. RE. This potential is the one set 
and read in the plot results. 

The potential WE vs. CE is referred to as the 'cell potential,' and it is recorded in special 
cases.  

In potential-controlled experiments, the potentiostat maintains a loop to ensure that 
the potential read (WE vs. RE) remains as programmed in the setup, consistently driving 
this potential towards the WE vs. CE polarization. 

This has the advantage that the potential drop across the counter electrodes interface 
is compensated. Another advantage is that the reference electrode does not carry any 
current and will thus keep a stable potential during the measurement. This means the 
potential of the working electrode is more accurate and reproducible. 

3.1.3 Using the EmStat4T as ZRA 

The EmStat4T can also be used as a Zero-Resistance Ammeter (ZRA). A Zero-Resistance 
Ammeter is a specialized mode used in potentiostats, primarily for measuring current 
between two electrodes while maintaining zero voltage (potential) difference between 
them. The ZRA mode ensures that no significant potential is applied between two 
electrodes, while the current flow between them is accurately measured.  

While keeping the potential difference near zero, the potentiostat measures the 
current flowing between two electrodes. This current is the main variable of interest in 
ZRA mode, providing valuable insights into processes such as corrosion, galvanic 
coupling, and other electrochemical phenomena where a potential difference is not 
deliberately applied but current is exchanged. 

If a potentiostat is used as a ZRA, in most setups it needs to be floating (Galvanically 
Isolated). The reference electrode (blue) and counter electrode (black) connections of 
the potentiostat need to be stacked and left disconnected to anything else. See the 
following image for a schematic representation. 
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Figure 13 - Connecting the EmStat4T cell cable for ZRA measurements 

The current flows through the working electrode lead (red) and the ground lead 
(green). The working electrode is connected to the input of the current follower and 
the + input is connected to ground. The voltage difference between the working 
electrode and ground is zero and the current will be measured.  

Use the technique Chronoamperometry in software to record the currents. The 
applied potential setting can be ignored. 

3.2 Using Screen-Printed Electrodes (SPEs) with the 
EmStat4T 

This section describes how to use the EmStat4T SPE version with Screen -Printed 
Electrodes.  
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The EmStat4T supports direct connection of screen-printed electrodes (SPEs) 
through the optional SPE Connection Module. This module enables convenient and 
reliable measurements using disposable or reusable SPEs with standard form factors.  

Follow these guidelines while connecting a Screen-Printed Electrode: 

1. Gently insert your SPE into the slot of the SPE Connection Module. 
2. Ensure the electrode is inserted fully, with all contact pads properly aligned 

with the module’s spring-loaded pins. 
3. Avoid excessive force or misalignment to prevent damage to the electrode or 

the module. 
 
For a list of compatible SPE manufacturers, visit our website: 
www.palmsens.com/products/sensors/screen-printed-electrodes/ 

Maintenance and Tips 

▪ Use SPEs only once if they are single-use; do not attempt to clean or reuse 
unless they are specifically designed for multiple uses. 

▪ Store unused SPEs in a dry, dust-free environment. 
▪ Periodically inspect the SPE Connection Module for debris or wear. Clean 

gently using a dry, soft brush if necessary. 
▪ When not using SPEs, consider switching back to the SNS Module for 

conventional cell connections. 
 

For best results, always use screen-printed electrodes that conform to the standard 
PalmSens-compatible layout. See also section SPE Connection Module pin-out on 
page 26 
 

  

https://www.palmsens.com/products/sensors/screen-printed-electrodes/




EmStat4T Operator's Manual » Standalone operation 

EmStat4T Operator's Manual 19 

4 Standalone operation 

The EmStat4T is capable of running MethodSCRIPTs with the extended command set 
for controlling the display and internal speaker. This section describes how these 
scripts –  which can be regarded as small apps –  can be developed, installed and 
maintained. The section also covers how the styling and naming of the user interface 
can be modified. 

4.1 Developing apps 
By using MethodSCRIPT™, small wizard-like apps can be developed for the EmStat4T. 
These apps can be loaded using the ‘Load Script’ button which is available in the Idle 
screen. 

 

 

Figure 14 - List with available apps on the display of the EmStat4T 

4.1.1 Files and folders 

The MethodSCRIPTs are stored on the EmStat4T in the folder “display”. There are four 
buttons available on the EmStat4T display to select a script, each button can be 
considered as a slot. Each script file starts with a number followed by an underscore 
that defines in which slot the script file is available. The “display” folder can contain for 
example the following script files: 
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▪ 1_My Demo 

▪ 2_Pb detection 

▪ 3_Cu detection 

▪ 4_Testing my QR code 

Each slot contains a file which contains a MethodSCRIPT™ which again can be loaded 
using the EmStat4T touch screen.  

4.1.2 Creating and installing an app 

The Visual MethodSCRIPT Editor, which can be found in PSTrace in the main menu: 
‘Tools’ →  ‘Visual MethodSCRIPT Editor…’ 

 

 

Figure 15 - The Tools menu in PSTrace 5.12 or later for opening the Visual 
MethodSCRIPT Editor 

Composing 

The Visual MethodSCRIPT Editor allows the user to compose a script by means of 
dragging and dropping commands from the list at the right-hand side of the window 
to the script. The software generates the corresponding MethodSCRIPT while 
composing the script. The script output can be seen in the ‘Script Preview’ pane. To see 
the script output click in the menu ‘View’ → ‘Script Preview’. 
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Figure 16 - Visual MethodSCRIPT Editor 

Installing 

When a script is ready for installation on the EmStat4T, click on the button ‘Install App’  
which is found at the right-hand side on the Toolbar. This button opens a window 
‘Download Script to Device’. The window allows you to set a name for the script and 
choose a slot button to install (see Figure 17) the script in. The new script always 
overwrites the existing script in the selected slot.  

 

Figure 17 - Downloading a MethodSCRIPT to the EmStat4T 

Deleting 

Deleting a script in a slot and making the slot empty again, is possible using the ‘Load 
data from internal storage’  window in PSTrace. To open this window click on the main 
menu in the PSTrace window: ‘Data’ → ‘Load data from internal storage…’. 

4.2 Configuring the style and behavior 
Certain images, colors, and labels on the EmStat4T display can be customized to 
enhance usability for untrained users or to align the user interface with a specific 
company theme or brand identity. 

 



EmStat4T Operator's Manual » Standalone operation 

22 EmStat4T Operator's Manual 

 

Figure 18 - EmStat4T display with customized UI 

The EmStat4T Configurator tool window 

The EmStat4T Configurator tool window can be found in PSTrace 5.12 or later under the 
menu ‘Tools’ → ‘Instrument settings…’ which opens a window showing the ‘EmStat4T 
Configurator’ button. See the figure below. 

 

 

Figure 19 - Instrument Settings window with button to open EmStat4T Configurator 

 

The EmStat4T Configurator window contains the following controls: 
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Figure 20 - EmStat4T Configurator tool window 

The checkboxes under Figure 20 –  1 change the following settings when enabled:  

▪ Skip Idle Screen: when the EmStat4T boots, the screen with cell readings is 
always skipped and the display shows all the available apps, either as a list or as 
tiles. 

▪ Use Tiles: makes the EmStat4T show tiles instead of a list with the available 
apps. The tiles can be customized (see Figure Figure 20 –  2) using images. 

▪ Customise Title: Replaces the default name “EmStat4T” with a custom one. 
▪ Customise Color : Changes the accent colors used in the EmStat4T user 

interface, for example the button colors. 

The area under Figure 20 –  2 contains a list with images that were added using the 
‘Add Image’ button. Each button can be configured to be used for a specific purpose. 
Options include using the image as: 

▪ Splash: This image is shown when the EmStat4T boots. The maximum size of 
the image is 240x320 pixels. It is strongly recommended to use a smaller image 
to prevent noticeable delays during boot-up. 

▪ UserIcon#: These user icons can be used with the ‘Update Display’ command 
in MethodSCRIPT. The icons should be 80 pixels tall and can be maximum 240 
pixels wide. 

▪ Tile#:  These images are used as icon for the corresponding app when the ‘Use 
Tiles’ setting is enabled. The size of these images should be 105 x 105 pixels. 

The settings can be saved and loaded with the buttons found at the bottom of the 
screen (Figure 20 –  3). This can be useful if the same settings need to be programmed 
into new EmStat4T’s. 

To store the new settings to the EmStat4T use the ‘Download to Device’ button, see 
Figure 20 –  4. 
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Firmware updates 

The regular firmware update tool of PSTrace cannot be used for firmware updates to 
the EmStat4T. Use the tab ‘Firmware Update’ in the EmStat4T Configurator Tool instead 
(Figure 20 –  5).  

See also section Firmware updates on page 33 
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5 Specifications 

5.1 System specifications 
The EmStat4T is based on the EmStat4M LR potentiostat module. Specifications are 
subject to change due to firmware updates; See the EmStat4T product webpage for 
current, detailed specifications.  

Table 2 - EmStat4T-specific specifications 

EmStat4T key specifications 

Housing 
  

aluminum body only: 11.1 x 6.0 x 2.7 cm  
with rubber sleeve: 11.8 x 6.8 x 3.3 cm  

Weight 310 g 

Power source USB-C or internal Li-Po battery 

Battery 
  

Connected via Bluetooth: 
~3 hours with cell on at 10 mA current (~5 hours with cell off) 

Communications USB Type-C port (recommended USB cable: supplied shielded 
USB฀C to USB฀A cable) or Bluetooth (4.0 - Dual-Mode) 

Internal storage 500 MB, equivalent to >15M datapoints 

Integrated QR barcode reader (supported formats and optical depth of field)* 

Compatible 
Formats 

UPC-A, UPC-E, EAN-8, EAN-13, Code 128, GS1-128, Code 39, Code 
93, Code 11, Interleaved 2-of-5, Matrix 2-of-5, Industrial 2-of-5, 
Codabar, MSI, GS1 DataBar, Datalogic 2-of-5, QR Code, Data 
Matrix, PDF 417, Micro PDF 417, Aztec Code 

Format Precision Near  Far 

Code 39 0.1 mm (4 mil) –  1.0 mm (40 mil) 25 mm 400 mm 

EAN-13 0.33 mm (13 mil) 50 mm 200 mm 

QR Code 20.0 mil 30 mm 210 mm 

* Test Conditions: T = 25°C, Illumination = 200 LUX, PCS = 0.9. The data provided above serves as a performance 
baseline indicative of standard scanner operations. For the complete, comprehensive technical specification visit 
the EmStat4T product webpage. 

 
Specifications are subject to change, due to firmware updates. 
See the EmStat4T product webpage for current specifications. 
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5.2 SNS Connection Module pin-out 
The following schematics show the EmStat4T cell connector pin-out and pin functions.  

        

Figure 21 - Front view of the female cell connector on the EmStat4T. 

Table 3 - Cell connector pin functions of the EmStat4T. 

Pin Function Connector color 

1 Reference Electrode (RE) Blue 

2 Reference Electrode Shield N/A 

3 Counter / Auxiliary Electrode (CE) Black 

4 NC N/A 

5 Working Electrode (WE) Red 

Connector 
housing 

Analog Ground (AGND) Green 

5.3 SPE Connection Module pin-out 
The following table shows the EmStat4T SPE connector specifications. 

Table 4 - SPE connector specifications of the EmStat4T. 

Connection pads 

 

Connection pads 
pitch 

2.54 mm (0.1”) 

Allowed sensor 
thickness 

between 0.1 mm and 0.8 mm 

Maximum sensor 
width 

10 mm 
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Ceramic substrates can have very sharp edges that might 
damage the SPE connector. 

 

 

When inserting a Screen-Printed Electrode (SPE), avoid touching 
the electrode areas. Finger contact can contaminate the surfaces 
and degrade measurement quality. The electrodes also connect 
directly to sensitive instrument inputs and touching them may 

cause electrostatic discharge (ESD) that can damage the 
circuitry. 

Handle the sensor only by its non-electrode edges and ensure 
you are discharged before insertion 
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6 Battery replacement 

Required:  

▪ Screwdriver: Torx 8 
▪ A 3000 mAh LiPo battery acquired from PalmSens BV 

Step 1: Open the battery compartment 

Unscrew the single screw and remove the battery lid. Then gently pull on the battery 
connector to disconnect it. 

 

Figure 22 - EmStat4X with the battery lid removed.  

Step 2: Place the new battery 

Connect the new 3000 mAh battery as received from PalmSens BV and place it in the 
battery compartment with the wires folded at the side of the battery.  
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The use of an unauthorized battery may compromise safety, 

pose a risk of fire, and result in irreversible damage to the 
device. 

Step 3: Close the housing 

Put the lid and the gasket back in place and close the housing. Do not use excessive 
force when tightening the screw. 
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7 Troubleshooting 

7.1 MethodSCRIPT error codes 
If the MethodSCRIPT of your EmStat4T app contains an error, a message in red will 
appear at the bottom of the screen (see figure below).  

 

 

Figure 23 - Example of an error message when trying to run an app 

The error code refers to a MethodSCRIPT error code which can be found in appendix A 
“Error code lookup table“ in the MethodSCRIPT documentation. The ‘Line’ number 
refers to the MethodSCRIPT line number and the ‘Col’ to the position on the line which 
triggers the error. This could be a missing or faulty argument for example. 

See for more information the webpage: palmsens.com/methodscript 

7.2 Verifying your potentiostat 
Your instrument can be tested by using the test sensor or dummy cell supplied with the 
instrument.  

https://www.palmsens.com/methodscript
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Connecting the dummy cell to the EmStat4T SNS 

The easiest way to verify the functioning of your instrument is to use the “WE B” circuit, 
which consists of a resistor with a value of 10 kΩ with a max deviation of 0.1%. The 
WE+Sense leads are connected to one side and both RE and CE to the other side of the 
resistor.  

 

 

Figure 24 - PalmSens Dummy Cell supplied with the EmStat4T SNS 

Connecting the dummy cell to the EmStat4T SPE 

In case you are using the EmStat4R SPE version, connect the SPE dummy cell. Keep in 
mind that this SPE has a simplified Randles Circuit with an extra 560 Ω resistor in series 
with the 10 kΩ resistor.  

 

Figure 25 The SPE dummy cell supplied with the EmStat4T SPE 

Running a test measurement on the dummy cell 

Any of the electrochemical techniques can be applied. The current response obtained 
with a resistor with value R is equal to the applied potential or potential pulse divided 
by the value of R. So, if a potential of 0.5 V is applied on a resistor of 10 kΩ, the obtained 
current should be 0.5 V / 10 kΩ = 50 µA. 

Contact PalmSens BV if the problems are found: info@palmsens.com and report the 
problems as detailed as possible. 

mailto:info@palmsens.com
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7.3 Noise troubleshooting 
Our instruments are designed with hardware noise suppression filters to reject noise 
from internal and external sources. If a higher level of noise is your issue, the solving 
strategies are rather numerous, but the sources for noise are also numerous. Here we 
describe the most successful and common methods for noise reduction. 

To determine the noise levels for your instrument, please refer to section Measuring 
the noise level of the instrument in the PSTrace Manual. 

7.3.1 Power grid 

Your power grid is an alternating current. This undulating current influences the 
measured currents. PSTrace have a filter for this mains frequency. In PSTrace, check in 
the ‘Tools’ menu under ‘General Settings’ if the mains frequency is set correctly (50 Hz 
or 60 Hz). 

7.3.2 Electric fields 

Our environment is filled with electric fields. Some of them are created by devices 
around us as side effects or in case of wireless communication on purpose. Although it 
is a bad idea to measure directly next to an electric arc furnace, it is usually not possible 
to have a workspace free of electric fields, especially not during point -of-care 
measurements.  

Nearby RF transmitters (Wi฀Fi routers, mobile phones, industrial radios) may be 
interpreted by the instrument as valid electrochemical signals. Measurements 
performed near such sources may therefore deviate from stated specifications. 

A Faraday cage is usually sufficient to create a field-free environment. A metal box or 
cage out of metal mesh is a good Faraday cage. Even a shield out of aluminum foil can 
help. Place your electrochemical cell inside the Faraday cage and connect the cage to 
the ground lead (green) of the potentiostat. The cable delivered with your instrument 
has an inbuilt shield and should protect your signal outside the Faraday cage. This is one 
of the most effective methods to reduce noise. 

7.3.3 Cables 

For optimal electromagnetic compatibility (EMC) and to minimise radiated or 
conducted interference, PalmSens recommends using only the supplied shielded USB 
cable. Longer or third฀party USB cables may behave as antennas and increase 
susceptibility to external electromagnetic fields, potentially affecting noise levels and 
measurement performance. 

7.3.4 Contacts 

Check if the contacts are corroded. If so, remove the stains, for example with 
sandpaper.  

7.4 Firmware updates 
The regular firmware update tool of PSTrace cannot be used for firmware updates to 
the EmStat4T. Use the tab ‘Firmware Update’ in the EmStat4T Configurator Tool 
instead.  

See also section Configuring the style and behavior on page 21 
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Bootloader emergency button 

If the EmStat4T firmware does not start correctly, it is impossible to remotely enter the 
bootloader to upload new firmware. In this case, a special button in the battery 
compartment can be used. 

 

 

Figure 26 - EmStat4T bootloader emergency button 

To use this function, open the battery compartment of the EmStat4T and remove the 
battery. Hold the bootloader button down while connecting the USB cable, and the 
device will appear as “STM32 Bootloader” for reprogramming. 
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8 Maintenance and compliance 

8.1 Temperature compliance 
Our instruments are designed for indoor use at ambient temperatures between 0 °C 
and 45 °C. All the components of PalmSens products (except their batteries) are rated 
to the industrial temperature standard of -40 °C to +85 °C. 

8.2 Humidity compliance  
PalmSens instruments have not been tested in high humidity environments. 

Elevated humidity may cause measurement errors if condensation forms on the 
electronics. This affects measurements mainly in the nA ranges or lower. Prolonged 
exposure to a condensing environment may severely decrease the life expectancy of 
the instrument and void its warranty. 

8.3 Temperature drift 
PalmSens instruments are calibrated at 21 °C. The most sensitive components of the 
instrument have temperature drift of 50 ppm.  For instance, at 1 °C or 41 °C, 
measurement drift of up to 0.1% may be experienced. 

8.4 Atmospheric pressure 
PalmSens instruments are not intended for use in safety -critical applications. 
Consequently, the power supplies utilized are not selected based on a specific pressure 
rating. 

8.5 Cleaning 
Make sure to disconnect your instrument from any cell or power source, if applicable, 
prior to cleaning. Use a lightly dampened cloth with either clean water or water 
containing a mild detergent to clean the outside of the instrument. Alternatively, you 
can use isopropyl alcohol. Avoid using a wet rag and prevent any fluids from entering 
the instrument. It is crucial not to immerse the instrument in any cleaning solution.  

8.6 Periodic calibration and preventive maintenance 
PalmSens instruments are designed in a way that eliminates the need for periodic 
calibration. While not mandatory, PalmSens does provide a calibration service for users 
with specific demands such as QC/ISO purposes. This service includes a new calibration 
certificate. 
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PalmSens instruments do not require preventive maintenance, further simplifying their 
use and reducing the overall maintenance demands on users. 

8.7 Service and repair 
Your PalmSens instrument contains no user-serviceable parts internally. Any service or 
maintenance needs should be directed to a qualified service technician employed or 
authorized by PalmSens BV. Attempting to access or modify internal components 
without proper expertise may result in additional damage to the instrument and voids 
warranty. It is recommended to rely on authorized service personnel for any required 
maintenance or repairs. 

8.8 RoHS Compliance 
All instruments from PalmSens have been built using lead-free components and lead-
free solder. They are in compliance with the European RoHS initiative. 
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9 Licenses 
This section provides an overview of the open-source software components used in 
this product, which are licensed under the MIT License. Each component is distributed 
under its own license terms, which permits the free use, modification, and distribution 
of the software. Below, you will find the relevant copyright notices and license texts for 
these components, ensuring compliance with the terms of the MIT License. 

By including these licenses, we acknowledge and respect the contributions of the 
respective authors and maintain transparency about the usage of third-party open-
source software. 

FreeRTOS (MIT): 

https://www.freertos.org/Documentation/02-Kernel/01-About-the-
FreeRTOS-kernel/04-Licensing 

 

eyalroz/printf (MIT): 

https://github.com/eyalroz/printf/blob/master/LICENSE 

 

mcufont (MIT): 

https://github.com/mcufont/mcufont/blob/master/LICENSE 

 

https://www.freertos.org/Documentation/02-Kernel/01-About-the-FreeRTOS-kernel/04-Licensing
https://www.freertos.org/Documentation/02-Kernel/01-About-the-FreeRTOS-kernel/04-Licensing
https://github.com/eyalroz/printf/blob/master/LICENSE
https://github.com/mcufont/mcufont/blob/master/LICENSE
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A. EU Waste Electrical and Electronic Equipment (WEEE) 
Directive  

 

 

The pictogram shown above, located on the product(s) and / or accompanying 
documents means that used electrical and electronic equipment (WEEE) should not be 
mixed with general household waste. For proper treatment, recovery and recycling, 
please take this product(s) to designated collection points where it will be accepted 
free of charge.  

Alternatively, in some countries, you may be able to return your products to your local 
retailer upon purchase of an equivalent new product. Disposing of this product 
correctly will help save valuable resources and prevent any potential negative effects 
on human health and the environment, which could otherwise arise from inappropriate 
waste handling. Please contact your local authority for further details of your nearest 
designated collection point. Penalties may be applicable for incorrect disposal of this 
waste, in accordance with your national legislation. 
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B. EU Declaration of Conformity 
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